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52UUUURN1S Macintosh

e Windows 7 (SP1), Windows 8,
Windows 8.1 or Windows 10

e 1 gigahertz (GHz) or faster x86-bit

or x64-bit processor
e 600 MB hard disk space available
e Minimum 2 GB of available RAM

e (CD-ROM drive required for
installation of shipped version
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download version)

macOS 10.10 and above
Intel-based Macintosh

Hard disk with 700 MB available
Minimum 2GB of available RAM

CD-ROM drive required for
installation of shipped version
(not required for installation of

download version)
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e Microsoft Word [Cite While You
Write] for Windows: 2007, 2010%,
2013* and 2016*

e Apache OpenOffice [Cite While
You Write] for Windows: 3.x

e LibreOffice [Cite While You Write]
for Windows: 4.x, 5.x, 6.x (32-bit)

Microsoft Word [Cite While You
Write] for Macintosh: 2011, 2016

(version 15.21.1 or later)

Partner integration for Cite While

You Write: Apple Pages

Partner integration for Cite While
You Write: Wolfram Mathematica 8
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e Partner integration for Cite While
You Write: Wolfram Mathematica
8

e Format Paper: Word processors

that save .rtf files:

0 WordPad for supported Windows
versions 11, 12, 13, 14

0 TextEdit for supported Macintosh OSX

versions 1, 2.x, 3.x, 4.x
0 Apache OpenOffice versions 1, 2.x, 3.x
0 Nissus Writer Macintosh OSX version

o Mellel versions 1, 2.x

e Format Paper: Word processors

that save .odt files:

Apache OpenOffice versions 1, 2.x, 3.x

e Format Paper: Word processors that

save .rtf files:
0 Word Perfect versions 11, 12, 13, 14

0 Apple iWork Pages versions 1, 2.x, 3.x,
4.x,5.2

0 WordPad for supported Windows

versions

0 TextEdit for supported Macintosh OSX

versions
0 Apache OpenOffice versions 1, 2.x, 3.x
0 Nissus Writer Macintosh OSX version

o Mellel versions 1, 2.x

e Format Paper: Word processors that

save .odt files:

Apache OpenOffice versions 1, 2., 3.x

S995UYANALITNITULEUD

e Microsoft PowerPoint for Windows
2007, 2010*, 2013*, 2016*

*32-bit and 64-bit
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TUsunsu EndNote X9 faifiuedosdiofvigludesnsdansussanynsauaynissnsds
Tuifom %aﬁﬂmamﬁ’aﬁugmuazé’ﬂwmsmw‘hmumaﬂUsLLﬂsu Faeludl (3301 auyIning,
2561, u. 15-16 91984l 8391y 13awenn, 2555, w. 30-32)

1. a1nseduAuINgIudeyanineInsasaumnavesalnlusisUTEmaALaz s ulays
poulaung q ¢

2. Waunsudavussanynsilusugiudeya (EndNote Library) ldilsisnnia 30,000 518ms3
fo 1 g1uteya

3. @unsaainegudeya (EndNote Library) lauinndt 1 giudeya (usaggiudeya
Sendn Library fuanaidu enl)

4. arunsaaireteyaussuiynsy lddeyaussuynsulaelideosAiiadq
nsldinTesmnenssanou adlusunsuaglaieiomneFEmuds

5. awnsaduAy wily Yudsedeyalusiemsussanunsula

6. aunsaarglaudaya (Import) IMNFIUTOYANTNYINTANTAULNAN DI AYAUAE
gudeyaseulatising q ileridnlusunsu EndNote 16

7. annsnaneleudeya (Export) senanlusunsy EndNote iteriluldfulusunsudu o 16

8. ansaionjukuuusIanunsulauInds 5,000 JUkUU (Styles)

9. mmiaLﬁaﬂ‘dszanﬁfﬁﬁuﬁﬁﬁa@ﬁazaaswmsmsmmﬂﬁm (Reference Types)
lavaneUseuny Juseann 48 Ussmeieiiu

10. ansouuuniugunn wiuds unugdl a3 dlenans uazdu q Blusenns
Ussanynsula

11. anunsadusensussanynsuanlid PoF AdaiivliluinIesneufinnesle
wilidionansidedudosiivansiay DOI

12, @10150AUNILENA15RUULANYBITIENITUTIUIYNTNIINB UL DT LTA
TagldiAds Find Full Text

13, anunsosaedidnes (Font) emauansaaldvanssuuuuiasmansun

14. gansadanisteyalaemsiuuinguvseasnenguees (Group) linatesuiuy

15. Tsunsusessunwingld

16. annsaidonles (Sync) Jeyaannenfiumesiadosdu 9 Tudilusunsu EndNote
Online way Endnote Application e

17. annsaldaulusunsusiuiussuulianis Windows wag Macintosh (Mac OS)
Inanunsaldausiuiulusunsy Microsoft Word wag PowerPoint b
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dquusznauveeldswnsy EndNote X9

FlofinsAndalusunsy EndNote asuuedosroufinneiudrngnussasdonieglu
awmes (Folder) ﬁﬁﬂé’ag 9 8y 6 liaines Fad (3501 auysalng, 2561, W. 16 91984l
W31 WIuNUaNS, 2550, U. 5-12)

1. Filters Ao Wlawmesfisrusiusede Filter fng 9 lunasihdeayaidn (Import)
ng1udeyaesulatggiuteyalu EndNote Library 19 ACM, ABI Inform, PubMed (NLM)
Hudu 39 Filter oa 9 wiandl funsana enf wagmindoansdwem Fitter lval 4 annsaudn
TUnsavaeusaziiiniinléan http://www.endnote.com/support/enfilters.asp

2. Styles fip THaLAD$71590U5IMFULUUNNTAITNENTUITUIYNT $1530518715819B4
(Output styles) 1nnn31 6,000 FULUU JUKUU Styles Afleaildiuily fio svuusiaiay (Numbered),
s8UUUL-U (Author-Date), S¥UU Harvard , S2UU Vancouver L0 Ua Y o) Styles #1149 9 SEAY
ULENA .ens Faanu130 Download EULLUULﬁm@ﬂﬁﬁ https://endnote.com/downloads/styles

3. Connections fie TaesiiAuseazduslumsidestedlusgudeyasaulay uas
grudeyavosioann nagrudoyafiliuinindrdudung 1wy PubMed, Ingenta LHugu uas
gm%’amﬂaﬁuaﬂ%’mﬂuam% \Wu ScienceDirect, IEEE Xplore, ISI Web of Science 1Jufu
#9 Connection File wiahifumana enz nmsiiimadenleddussgudeyasoulating 1

4. Term list fio InatmesNdaLAuTI9d0215815U LAl ua191LAT (Chemical),
a1 unneAans (Medical) waganviuyveenans (Humanities) taedauiulugy Text File
ansnisedorsasvadulily InevhmedemandludaAuliludin Jounal Term List
989 EndNote Library axviliisnedensansluaaniy q iunniy

5. Templates Ao lamesfidafiusianis Template vaan1sdarhduatuunaing
Y95aseine q Msld Template F8l#giITsuunauYszndanarluienisingluuy
nMsSndshuseng q veailem shlvazmnlunswssuunenuieaiulunsansly

6. Examples Ao Inaiesfidaiiudeg1snsldaulusinsy EndNote Tnefigiudeya
Library @9 Paleo daazdmfusienisussanynsy 5au9ai08719090 91979 uag Paleo.Data
Widteltannsadnwinisldals
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Junaun1sAIUluanlusunsy EndNote X9

gdnIneusniswazmaluladansauna alusn1siusensy EndNote X9 d@1nsu
55UUUURNTS Windows wagszuulufinig Mac wieugiieusznounisldauniuivled

YDINBIALA www.library.rmutt.ac.th

gldvimsanunsadfauimsriuivledresayaiiennidlvanlusunsunazgile
nsandalusunsuld vt iumae EndNote Program nneldavade anaidluanlusunsuuas
Adon1sld warlunisanilvaslusunsuglduinmsarunsaidenaiivanlusunsulnseiu
sruuUfoinisvonadnsneufiunosiildaney m Jagiu ddl

1. wWduled www.library.rmutt.ac.th

= < s v
A 1 uledviesayn
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2. ﬂaﬂmi{} e-Resources > 1don EndNote Program

a
ANN 2 by e-Resources

3. Whgviima EndNote Program > viide antilvanlusunsuuazeilon1sly laeiden
anlvanlusunsulvnsaiuseuuluRnisvesneuiiunainldnueg

aniluaaldsunsuuazgiianisizdeiu

Tusuwnsu EndNote

Name Size Hits
[ 01- lalsuns: EndNote x9 for Windows 100.0MB 1120 ]
02- Talsunsa EndNote x9 for MAC 90.2 MB 100
03- Tilsunsu EndNote x8 for Windows 89.6 MB 177
04- Tilsuns3 EndNote x8 for MAC 93.1MB 53
05- Tilsunsy EndNote x7 for Windows 81.5MB 123

AW 3 v unannilvanlusunsuiazeilonisiday
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4. \deadna1idlnanlusunsy EndNote X9 for Windows > falUsunsuazgn
anullannuliin Folder : Downloads

anulunanTlsunsunazqianislueiu
Tusunsu EndNote
Search n
Name Size Hits
01- Tlsunsu EndNote x9 for Windows 100.0 MB 1120
02- Tisun7i EndNote x2 for MAC 20.2 MB 100
03- Tilsun3u EndNote x8 for Windows 89.6 MB 177
04- T1lsun7u EndNote x8 for MAC 3.1 MB 53
05- T1lswn3u EndNote x7 for Windows 31.5MB 123
@ EndNote-Xg-WIN.rar ~ samaiovna )
B

2NN 4 NsAlanlUTHENTY

5. Wenmilvanasassusosudd vinsusnlng zip Wsunsuneufess (nndudarand
1d zip Wealavinnmsfenlusinsuazlianansafnasiusunsule) Adna19lvad EndNote-X9-
WIN.rar > 1§9n Extract to EndNote-X9-WIN

) -

Media Info
g Extract files...
)} Extract Here
[ | | EndNote-x9-WIN | €— [ Esctto tnanoicrovm, )

@ Scan with ESET Endpoint Antivirus
Advanced options >

|2 Share
Open with >

Give access to >

Restore previous versions

Send to >

Cut
Copy

AW 5 nsuanlng zip
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A15A9AT VPN-RMUTT naun1sa1ulvanluswnsy

VPN-RMUTT (Virtual Private Network) A9 tA3091887Uf L@l auraInIauning &
welulafsuseasyyd Wumslidnsiedunmevaussnudosslunisldmuaiods
Y9IUNIINYaE Y nngusnunInetae (Jun1sld Modem w38 adsl nisiA30U1Y
Internet 3u 9 lildiaTovredumesidnvesminends)

ldusnsiidiosnsanilvanuagldsnlusunsy EndNote X9 Bsfilalduinsiaetne
Sumediinvorminerdss du dlivsnsdesinisfiage VPN fiedasroufanesvasmuies
Aoumsailnanlusunsy Tnenisinsadunsldmunsideuseniuesnines 202.44.131.121
Faavvmsindauazieinnisldauiisudadaionmitiy mmimﬁ’%ﬁuﬂﬁaﬂ&%mu@jﬁams
#adn VPN-RMUTT aratiesduvesgunsaiiildesiuogludiagdu lnoidgaiieldd
www.library.rmutt.ac.th/?page_id=9514 wagn1sidldeudesin1sseysianiu s?iﬂLﬁuszgm
Weatunis Login wWhldaueSotnedumesitn WiFi vesumndnends wdaninvinisieuse
VPN-RMUTT 138u50sud fsanansaaniiluanlusunsa EndNote X9 wieusn License fiog
auldnisliuiniseesuniinerde« la nsdlinnisanaulnanlisunsy EndNote X9
usniAIetevesInerde laglalsvihnsidensie VPN-RMUTT flduinisazliuaifissh
TUsunsu ENX9lnst.msi i1y wsazldlng License.dat uawdoufunisanadivan
Tunsfnga VPN-RMUTT mmﬂ%’u‘%mﬂﬂmmmam&gﬂLLazé?qmm{L%mulﬁ A10150ANGB
aoupusivazideafiuAuldd Tns 0-2549-3074 niedadevelduinisldi
91A15 i-Work d1inineuinisuasinaluladarsaund
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JUNDUNITANALUSENTY EndNote X9

n1sfnmalusunsy EndNote X9 d1915UszuuUiiins Window 1285¥uves
sruuUfUAnIsAisesfuiiu EndNote X9 TéiA Windows 7 (SP1), Windows 8, Windows 8.1
uaz Windows 10 haznuislszinananauiinesazdesiialn 1 gigahertz (GHz) %30 32 O
(x86) %30 64 T (x64) Uagdm3U Word Processer Software fisas3ufiu EndNote X9 ¢
Microsoft Word 2007, 2010%, 2013* uag 2016*

1. 1 WalnamasndmAulusunsy > sutbananidllusensy ENX9lnst.msi (\Dulndnns
AnUszlnn?dllng License.dat @alddmsudniu Product Key 1nnsauiunsuniulvan)

AN 6 FLUSHASURARI ENX9nst.msi
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2. Adn7IYal Run wiaisun1sinsslusunsy

o v a a o
AINN 7 ﬁu’]@’]ﬂﬁﬂﬂqﬁmﬂ@ﬂiﬂi%ﬂﬁﬂ

3. Lﬁaﬂi’mgwﬁwm Welcome to EndNote X9 > ABnfds Next

)

A 8 Miieing Welcome to EndNote X9
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4. 11619 EndNote X9 Volume License Version 1USwNSua8ha9518a81980 License
YDINWNINYNAY > AANAIFS Accept

)

AN 9 MANY License Version

5. 1819 Read Me Information vNenfus18aztdenuadluswnsy > AanA1&aa Next

]

AN 10 #1619 Read Me Information
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6. 11719 License Agreement > AdnLaen | accept the license agreement LN ©
gonsutouly > MnUUAANAIEY Next

O )
2 Ju—

2?11 weg License Agreement

7. ie13 Select Installation Type tUun1sidionguuuunisfinga > \dan Typical >
INUUASNAIES Next

e Typical fia N15ARAWALUTINTUNTTINNUYES
D TUsunsu EndNote Msnug

Custom Aa N5LEBNANALRNIELUIWATUNIS
YM91UY89lUSHASY EndNote NABINSLVINT

@
—

AT 12 e Select Installation Type
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8. Mt Select Destination TUswnsuwaslasnnasinawmasnlglunisaanuluswnsuy
WnfesMsideundniiu many Browse mnlufssnisildsundadla o > AdnAde Next

]

A 13 e Select Destination

9. ¥ti1M19 Ready to Install the Application Wuntin1sdudunisandalusunsy >
AANAEY Next

]

A 14 wteng Ready to Install the Application
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10. n#i19 Updating System TuUsunsuagsenineinsansa

Al 15 mene Updating System

11. 9zU5nni1eg ...successfully installed > AANATAS Finish Lilota5adun1sAngs
TUsunsy

)

AN 16 MRS Finish

nsldelusunsy EndNote X9 Tunsdnnisdeyaussanunsudmiussuud]uinis Windows 13e3%u Desktop



Ugymriionanulunisiinaslusunsyu EndNote X9

1. mnUsngudeng File In Use sewinsfinsaiusunsa iunsudasiouiiimada
THmilusinsy Microsoft Office og) TivinnsUalusunsy wielslusunsa EndNote sihnsiledn
Undunsldamlulusunsa Microsoft Office (Word, PowerPoint, Outlook etc.) Iér iiovin
mMsUalUsunsuiisadeands aandidnds Retry

2. mnmsAnsalusunsy EndNote X9 nuilyymmsindalugau Explore Helper il
wihaansansadnadunaiuy awnsuilonuduney dil @53 wsmuws, 2560, . 6)

2.1. Budndalusunsy EndNote X9 lusidnads
Tnerdniilild ENX9lnst.msi ewndewmssnsiilidennis
Aadelusunsuuuy Typical Install Whdsududonnns
AARILUU Custor Install Wy ansunanit Next

2.2. dlounngwiieing Select Features 1unshi
Gonmsvihmuvedusunsulathaidessands dunmlddneed
FodvRuliAniodoniam @Jﬁ' Install Direct Export Helper
é’aﬂajﬁm‘%amma%ﬂaghﬁmﬁ islsidenmsings Feature
# wmnhdsimsasdalusunsuauaSadunssuuns ( )

2.3, loRasalusunsuadaudlud Drive: C > Aanillnlawes Program files (x86) (dmsu
Window 10) > pdniilalatned Common Files > pdUillnlWatned Risxtd > a1ty copy file
Risweb32.exe waz Risxtd32.dll lumal3filnawnas EndNote X9 wio C\ Program files\ EndNote X9

3. mniin1s Upgraded Microsoft Office widsannnsinsalusunsa EndNote X9 lUuda

il978n15 Setup lUsunsu EndNote Tninadanils Ingldonnisnsawuy Custom Install
WEaRaRa Add-in support dnumsidnuduiiiendn CWYW (Cite While You Write)

4. yndeens Upgraded 1osdulusunsy EndNote dalwal Tunsdifivnefnsalusunsa
EndNote nastuiiiinitasedesnauiiunesling Tivinnnsdrsestoya EndNote Library Ul
firdesneuimessuteu wiadiUnlusunsuiiistesiomndiol’ Addin support #ldeu
aufu Microsoft Office Wasuduneiduaian anifuhnsaeunisfiafs EndNote Lo5dauirn
A1 WU Control Panel > A@n Programs and Features (Windows Vista or Windows 7, 8, 10)
> 1don TUsunsu EndNote > Adn Uninstall lewaSanisaeunisinge > Tiinisinsaiesdu
dnanlneidenmsfinmauy Custom Install 9uiaSaAunszuIuNs (Clarivate Analytics, 2019b)

5. madanesduilinuegtagtiuindunesdudanudeds Widalusunsy EndNote
TnoAdndiay Help > Adn About EndNote #1U5707) EndNote X9.3.1 (Bld 13578) uansiniy
nostuanaaudndmsuszuuURns Windows 1i3emrdniidnds Check for Updates... Wilai3eng
neituagaveaiilusunsy wagihaumuuzitvuntiae wndilalyiesduaiannin
Download and Install laiedadunssuiunsdmanineiduasadamssmenilyadnads
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n1sisandalusunsy EndNote X9

1. AdNAYy Start ¥89 Windows 3gU351nnn619 All Programs lagazilnaines
EndNote iunNun @9kn15:80niAanunuinsetelusknsuNniuauniesnses £

N

AR 17 wieg Windows 10 wag Windows 7

2. pdnlnaimes EndNote > aan EndNote Program > A@N? | accept the license
agreement LegUSU > NUUARA Next

EndMote @

ENDNOTE EMD USER. LICENSE AGREEMENT

BACKGROUND, Thomson Reuters (Scientific) LLC has developed a proprietary software application
known as EndMote® (the "Software™). By using the Software and/or its accompanying manuals
(the "Documentation”™ and together with the Software, the "Product”), you (the "End User™) agree
with Thomson Reuters (Scientific) LLC to be bound by the terms and conditions set forth herein,
Thomson Reuters (Scdentific) LLC is wiling to permit you to use the Product only upon the condition

1
THEREFORE, for good &M vAMable con a o

sgreement, and ntenina tobe lesalyl  AANT | accept the license agreement tagau5U
agree as folows: Vi 1

, e crad, Subect o e e INUUAGNT Next iitaitngnislday

(Scientific) LLC hejeby grants t0 ENd S, e wm o o oo o oo oo o o o o —_—— ——
use the Product folely for the purpose of searching online resources for references, creating and
building & persqfial librarv of references. formatting references. and creating uniform citations and ™

l-@- I accept the license agreement l

(") I do not accept the license agreement

l Next | Cancel

A 18 niheenisgensutennadluayn
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3. agUsnguiiieseusulunisdldnulusunsuasausn @msunisliazdsing
wanseRgviiulumadaldnulusunsudunsausn)

» wihsansudadieunestuiildnuey
Tagu uaghostudnanaign

AR 19 wieg Welcome to EndNote

4. %199 EndNote Library TulUsunsu EndNote X9

A 20 wthae EndNote Library
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n5UAtYulUsNSU Microsoft Office

1. Woalusunsu Microsoft Office Word asnudndiuauiuyardanisidaulusunsy
EndNote X9 wisidan Tunisldanumumdaiang s sesdanisldanulusinsy EndNote aaug
nsldanuluieiu

)

A 21 wthae Microsoft Word 2013
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2. Tudiuveslusunsy Microsoft Office Power Point 1uiuagnudnduauluudanis
Tdaulusunsy EndNote X9 wisdun Tunisldanuuymdsing s desdanisldaulusunsy
EndNote augnistdaulusieiu

)

mwﬁ 22 %1198 Microsoft Power Point 2013
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A15A9ALAZNI5 IFUIUSHASY EndNote

nsadsaznsilanasiudayaussanynsa (EndNote Library)

EndNote Library Ao adaifiuteyaussanynsy Wudwilflunisdaiuteyasens
ussaynsuuarliddidnrseindussiandng q figitestumenisussanynsudy q wu
sUnm, N9, 11519, Tdenans PDF, Tidenans Word 1Jusiu %ﬁmﬁﬂ”ﬂué’ﬂwmsgm%ga
viosayndIusa (Private Reference Library) Tunnsagtieudoyaidn EndNote fosadrsiiu

AuSuNsIUNUATILINADUY F9agt3anin Library Inefidunaussil

b % L < Y .
nsaseARNUTayauTIAIYNIH (New library)

'
a

AaNTWY File > AAnEBN New...

o A v v [ | .
Ratennetoyatnilures File name
denlasndmsuiaiuadsdeya (Wmsdanulilulasnideduiudilusunsy)

AANAAY Save watufinaduiudeyal

A NS .

Unnguihanseaaiudeyall

il 23 Msadepdaiutoyalua (New Library)



Al 24 viheeedafudoya (EndNote Library)

Uszunnlndvasadanudaya (EndNote Library)

1. adufudeyausazgrudeyaiiondn Liorary axfideunuanalwdidu enl

2. lefimsatendafudeyalva Tusunsuazai1e Folder fiflumanalwdidu Data
Faazfideiiienuiu Library Lﬁaﬂmums%’mﬁdw&ﬁaaﬂam 7 289 Library th 9

3. ndesnisfe Drive dafiudeyalual 1vhnis copy Iddeyaiaumana enl

way Data lalenunaaaslud

—\ My EndMote Library X9-YA.Data
| My EndMote Library X9-YA.enl

i 25 Tidaduiudeya
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nsandaiudayaussanynsufitiogidu (Existing library)
1. adniuy File > Adniden Open Library...

2. \denadunudeyanioet

3. AANAYEs Open LiielnAdunudoyaUsTILNTY

& EndNote X9 - m} X
File Edit References Tools Window Help
New...
Open Shared Library... Ctrtl+Shift+0
Open Recent >
Close
EN, g
— — & Select a Reference Library:
Save As.. « “ 4 > ThisPC » Local Disk (D) v|®|  Search Local Disk (D) ¥
Save a Copy...
L Organize ~ New folder =~ @ @
Revert =
-~ - - ~
— o This pe Name Date modified Type Size
- . -
B 30 Objects || Lightreom_Backup 5/10/256117:25 File folder
Export.. || Lightroom-¥DO 5/10/256117:29 File folder
[ Deskiop
Import > - || My EndNote Library (se504).Data 5/10/256117:29 File folder
e — Documents || My EndNote Library (oussi).Data 5/10/2561 17:29 File folder
R & Downloads || My EndNote Library X3-VA.Dats 20/2/2562 10:35 File folder
rint Preview
Pt b Music || Scan 5/10/256117:10 File folder
it Setup...
" ] Pictures [ SMEs 5/10/2561 17:32 File folder
Compressed Library (:enk) ... B Videos || wiriya 9/6/2562 16:37 File folder
1 A
- p— 4 Local sk (C) || n<lan 5/10/256117:53 File folder
- [ ssamines 5/10/256117:53 File folder
— Local Disk (D) o
%l My EndNote Library (#aag4).enl 21/2/2562 16:07 EndNote Library 132KB
= My Passport (F) % Wy EndNote Library (oussi).enl 30/3/2560 23:17 EndNote Library 22kB
= Library (W17220 %) My EndMote Library X9-YA.enl 20/2/2562 10:35 EndMNote Library 0KB|
File name: | My EndNote Library X0-VAenl Libraries ["enl"ibmeny) v

il 26 wieerdunulayaian
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nssulduaduivteyagldauisanilunisdarnsuduvesguuuudidnes (Font)
wazn1sUTuagunsdnneiunisguiuureantine (Layout View) 1¢ iitelvinsuanua
YodlUsunsuTvamdnuIkar JULUUTTNAenNANRINslladaldny fall

N1SALAINISUERIFULUUAIBNES (Font)

N9UABUTULUUAITN YT LH0991nYUIAFITN WS ANINTBUAUNITAIATUAY
Yaalusunsuo1ativuiaan saudslunsaimusunsuliaiunsasudisnwsnwlnelaasvinla
HNaRaN1TWENINARITNYINIUNL120D USRS TUN15AIAINISITIN UL T DIAUIE1U15D

MU TUnoU fAaslUl

1. A@nuy Edit > AANAAS Preferences...

2. wUNNgnsg EndNote Preferences > AANAI&4 Display Fonts

3. Vcl”m’ﬁl,ﬂalaugﬂLLUUﬁ?ﬁﬂUSﬁLLﬁUﬁWﬁL\‘i Library, General, Labels Wag Search
Tunnddafielivnvihasiivuinguuuusdnesiiuaziloudu

4. man Change Font...

5. @onguuuufdnusuazIuInTidedns

6. Ands Script laginlusunsuamsnsuguuuuisnusinglivieli (den Thai
ntuadin OK

7. \flowAsuasunnuitudndiuds edn OK isladadunisdaen

Undo Ctrl+Z
Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V

Paste With Text Styles
Clear

Select All Ctrl+ &
Copy Formatted Ctrl+K
Find and Replace... Ctrl+R
Font 4
Size L
Style 4
Output Styles 4
Import Filters 4
Connection Files 4

Preferences...

AN 27 NUIH19ANES Preferences...
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AW 28 wtienedds Display Font

N13ALAINITUTULURBUN1TIRNSAUMLs UL UUYRTNRe (Layout View)
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